Chapter 1 1

Web Design in MS Word

In this chapter, we will learn the following to World Class Standards:

Understanding Web Design

Storyboarding the Web Page

Opening and Saving the Document as a Web Page
Changing the Font and Font Size

Adding a Hyperlink

Inserting an Image

Inserting an Indented Bulleted Information
Creating a Mail To Hyperlink

Inserting a Copyright Statement
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Understanding Web Design

Most web designers start learning Hyper Text markup Language or just plain HTML. In learning this
form of coding that allows anyone to read our documents over the Internet, you have to learn how to
arrange the code so your words and images successfully transmit to another computer. However, there
are programs such as Adobe Dreamweaver that allow the programmer to design the web layout page
and automatically generate the code. Microsoft has developed a similar feature allowing you to
convert any Word document into an Internet-ready file by saving it as a web page. In this lesson, you
will start with a simple file that all web designers should create: the web designer’s page.

When designing for the web, you will want to use techniques you have learned in previous lessons.
Here you can avoid working on a title page or homepage since it is somewhat complex for a new web
designer; instead you will save that page for your fourth web document. You need time to practice
constructing simpler templates to learn quickly and make progress on your project at the same time.
Since web projects can take more time to create than regular documents, you will want to work from
simple to complex, ensuring that less experienced designers do not lose interest.

We want to caution the new web designers who are making their first web page. Do not feel that you
need to erase your work and continually start over again. Less practiced designers will delete their
work because they believe that the page is unacceptable. In the web design field, designers wait until
the work is done and then let a focus group review the entire project. After recording comments, the
designer can decide what modifications need to be made. A single designer might not like the original
concept, but web users may. Learn to listen to the people who read your Internet documents.

Storyboarding the Web Page

You can begin the storyboard
process by jotting down a few
ideas on a piece of paper. For
images, you can use stick figures

or simple ovals to represent i
portraits that will be in the web —
page. By constructing a simple
roadmap of what you are going to
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do, you can avoid the wasted time
of staring at the Microsoft Word
display and trying to think of
what to write. We tell our web
designers that they can always go
back and update the web designer
biography as they gain more
experience.
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Figure 11.1 — Initial Storyboard
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Many times, you will open applications like Microsoft PowerPoint and make our storyboard in that
software, where entities are easy to move around. We can experiment with different font styles and
sizes to arrive at a solution.

Home

About the Web Designer, John Smith

John Smith is in his freshman year and will earn a two-year degree in graphical design from Bradford School in Columbus specializing in digital design. John is certified in the
following types of software applications.

Adobe Photoshop

HTML Web Development
Adobe Dreamweaver 92
Adobe Flash

Although this is John's first website, he plans to specialize in these kinds of web projects:

Professional Sports
College Sports
High School Sports
Amateur Sports

To discuss John working on a project for you, email him at jsmith@ohiodigitalart com.
Copyright © 2010 by Ohio Digital Art. All Rights Reserved

Figure 11.2 — Storyboard the Web Page
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Figure 11.3 — Making a Web Project Folder
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Opening and Saving the Document as a Web Page

Open a new Word document and save the file by clicking on the Save tool on the Quick
Access toolbar that is located at the top left of the program. The Save As window will

appear in the display. You can save the file into the

folder you have already created.

Save the document with a description

@ Save As

that tells us what the document is

() [H « wec2010 » Web Project

x | +3 | | Search

about without having to open the file.
Type “web_designer_biography” as
the file name and then change the file
type to “Web Page” as shown in
Figure 11.4. When you save a web
file, you should create document titles
that are all lower case and use an
underscore ( _ ) in place of a space
between words.
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. 2010
wee2010
Web Project
{| Documents

= Hide Folders
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Name Date taken Tags Size

This folder is empty.

File name: web_designer_biography

Rating

Save as type: [Wond Document

Word Document

Word Macro-Enabled Document
Word 97-2003 Document

Word Template

Word Macro-Enabled Template
Word 97-2003 Template

PDF

Authors:

XP5 Document

Web Page, Filtered

Rich Text Format

Plain Text

Word XML Document
Word 2003 XML Document
OpenDocument Text
Works 6 - 9 Document
Works 6.0 - 9.0

Single File Web Page P

Figure 11.4 — Save the Document

Changing the Font and Font Size

Under the Home tab, on the left side of the
Formatting toolbar is the Font Listbox. The
default font and size for Microsoft Word 2010 is
Calibri with a font size of 11. You are going to
change the font to Impact and the size to 72.
Begin by clicking the left drop-down arrow of the
font Listbox to select the font style. The font
styles are in alphabetical order, so scroll down
until you see Impact and select it (Figure 11.5).
After picking the style, click the drop-down
arrow to the right of the font style box and select
a font size of 72.
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Now, you will type the website name at the top of the page. This website is about the organization,

“Ohio Digital Art”.

-------------- |\ || IR |~\-|1|11\1:IAP~|

Ohio Digital nrﬂ

Figure 11.6 — Typing the Banner Name for the Website

Adding a Hyperlink

Next, type in the word “Home”
with Arial font and at size 12.
Highlight the word Home and
right click on the shaded area and
a popup menu will appear. Click
on Hyperlink as shown in figure
11.7.

The Insert Hyperlink window will
appear on the graphical display.
Type “index.html” at the Address
textbox. If you already had the
webpage completed, you could
select the page from the list of
web pages in the web project
folder. To complete the hyperlink
task, pick the OK command
button and a blue line will appear
underneath the blue word Home.

Arial 12 - A *- i=
B I U :aj A
Homa
% ot
53 Copy
[, Paste Options:
=|
Font...
Paragraph...
Bullets | »
MNumbering | 4
Styles

Hyperlink...

® TTT il =

Look Up
Synonyms
55 Translate

Additional Actions »

Figure 11.7 — Setting a hyperlink
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Pages
Create New Recent
Document Files
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[ oK ] | Cancel

Figure 11.8 — Typing “index.html” for the Hyperlink
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Inserting an Image

Insert
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References Mailings Review

Figure 11.9 — Inserting Picture on the Drawing Toolbar

Hit ENTER twice to get the
cursor two rows below the Home
hyperlink. We are going to add a
portrait of the web designer (you),
so select the Picture tool on the
lllustrations panel under the
Insert tab. The command will
take us to the Insert Picture
window that contains files of all
of our pictures. Select the portrait
from the image folder in your web
project folder. Click on the Insert
button and the picture will be
inserted the web page.

Just to the right of the portrait,
type “About the Web Designer,
John Smith” using the same Arial
font at size 12. The web page
should appear as shown in Figure
11.11.
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& Computer B
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Figure 11.10 — Inserting a Portrait Image

About the Designer, John Smith

Figure 11.11 — The Image and Text
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Inserting an Indented Bulleted Information

Below your next entry, you will add a bulleted list describing software application in which you are
proficient. To do this, go to the Bullets tool on the Paragraph panel under the Home tab and select the
single round bullet. Now you need to enter all of the applications. To start a new bullet, all you need
to do is hit Enter. To end the bullet command so that you can enter a new sentence, all you need to
do is unselect the bullet command and then repeat the formatting you used earlier to enter the new

information.
[FEe)i= - 4=  2=3= | A
SriECE EE 2T aaeecend A
Bullet Library T
A

None ® O ] + 0’0

> v

Document Bullets

||

Define New Bullet...

Figure 11.12 — Bullet Tool

You indented the bulleted list by highlighting the
four bullets and then selecting the Increase
Indent tool on the Paragraph panel as shown in
Figure 11.14.

John Smith is in his freshman year and w
the following types of software applicatior

» Adobe Photoshop

¢ HTML Web Development
e Adobe Dreamweaver 92
s Adobe Flash

Figure 11.13 — Bulleted Information
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Paragraph

Figure 11.14 — Increase Indent

We type in the websites we wish to design for our second bulleted list following the same techniques
we have just learned. Our webpage should appear as shown in Figure 11.15.
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Ohio Digital Art

About the Designer, John Smith

John Smith is in his freshman year and will earn a two-year degree in graphical design from Bradford School in Columbus specializing in digital design. John is cerified in the following types of software applications.

* Adobe Photoshop

* HTML Web Development
* Adobe Dreamweaver 92
= Adobe Flash

Although this is John's first website, he plans to specialize in these kinds of web projects:

* Professional Sports
* College Sports
= High 3chool Sports
* Amateur Sports

Figure 11.15 — Indented Bulleted Information

Creating a Mail To Hyperlink

Next, you will type in the next sentience stating that we can contact John Smith. Highlight the web
address and right click on the shaded area and a popup menu will appear. Click on Hyperlink as
shown in Figure 11.16.

John Smith is in his freshman year and will earn a two-year deg== =Em~—~n'~=-=~' cdoniqg
the following types of software applications. B
=3 Copy
+ Adobe Photoshop [, Paste Options:
» HTML Web Development = 57 (v A
s Adobe Dreamweaver 92 A Fort.
+ Adobe Flash =% | paragraph..
Although this is John's first website, he plans to specialize in th z s ) lb
i=  MNumbering | »
+ Professional Sports ‘9“ e '
» College Sports & Hyperink..
+ High School Sporis Look Up g
+  Amateur Sports Synonyms g
'2 Translate

. . . o . - Additional Actions »
To discuss John working on a project for you, email him at JSmitl e e

Figure 11.16 — Adding a Mail To Hyperlink
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The Insert Hyperlink window will
appear on the graphical display
and this time we will pick the
icon Email Address on the lower
left of the window. Type the
email address
jsmith@ohiodigitalart.com in the
E-mail address textbox. We can
see the recently used emails in the
list box at the bottom. To
complete the hyperlink task, pick
the OK command button and a
blue line will appear underneath
the blue word Home.

Insert Hyperlink @Ii_hj
Link to: Text to display: |jsmith@chiodigitalart.com

E-mail address:
Existing File or | | mailto:jsmith @ohiodigitalart.com

Web Page
Subject:

Place in This Recently used e-mail addresses:
Document

Create New
Document

E-mail Address

oK ] [ Cancel

Figure 11.17 — Adding a Mail To Hyperlink

Inserting a Copyright Statement

Add a copyright statement for the
web page as shown in Figure
11.18. To create the copyright
symbol type “( ¢ )” and the
symbol will automatically appear.

Whenever you need a symbol that
is not on the keyboard, you can
open up the Symbol window by
picking the Insert tab and
selecting Symbol. Select more
symbols and the Symbol window
will appear as shown in Figure
11.19. There are two tabs at the
top of the dialogue box, Symbol
and Special Characters. To access
the copyright sign, pick the
Special Character tab.

him at jsmith@ohiodigitalart.com. |

Copyright © 2010 by Ohio Digital Art. All Rights Reserved

Figure 11.18 — Adding a Mail To Hyperlink
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Figure 11.19 — The Symbol Window
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mailto:jsmith@ohiodigitalart.com

Common business signs such as
copyright, trademark, and
registered are shown on this tab as
seen in Figure 11.20. To insert the
copyright symbol, you could
highlight the line as shown and
press the Insert command button
and the copyright symbol will
appear in the web page document.

Symbol

Symbols | Spedal Characters

Em Space
En Space
1/4 Em Space

® Registered

™ Trademark

g Section

i Paragraph
Ellipsis

Single Opening Quote
Single Closing Quote
Double Opening Quote

"

Alt+Ctrl+R
Alt+Cirl+T

Alt+Ctrl+.
Ctrl+*,"
Ctrl+,'
Cirl+","

Character: Shortcut key:
— Em Dash Alt+Ctrl HNum - -
- En Dash Ctrl-+HMum - B
Maonbreaking Hyphen Ctrl+5hift+_
- Optional Hyphen Ctrl+-

= Monbreaking Space Cirl+5hift+5pace
@ Copyright Alt+Ctrl+C

m

AutoCorrect... l lShortcutEey...

Insert

] ’ Cancel

e

Figure 11.20 — Special Characters

The finished web is shown in Figure 11.21. You can double click on the file in the web project folder
and the document will open Internet Explorer or another web browsing software for viewing. If we
double click on the email link, your email application will open and a new email will launch with the

email address in the mail to box.

To practice for simple web page construction, you can make FAQ, Privacy Policy and About Us

pages, which are simple to put together. The finished biography is shown below.

11-10



f,.; CAUsers\Joe\Desktop\WCC\Web Project\web_designer_biography.htm - Windows Internet Explorer
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Home

Aboutthe Web Designer, John Smith

John Smith is in his freshman year and will earn a two-year degree in graphical design from Bradford School in Columbus specializing in digital design. John is certified in the following types of software applications

« Adobe Photoshop

s HTML Web Development
« Adobe Dreamweaver 92
« Adobe Flash

Although this is John's first website, he plans to specialize in these kinds of web projects
* Professional Sports
«  College Sports
= High School Sports
«  Amateur Sports

To discuss John working on a project for you, email him at jsmith@ohiodigitalart.com
Copyright @ 2010 by Ohio Digital Art. All Rights Reserved

Dene M Computer | Protected Mode: Off fa v ®i5x -~

Figure 11.21 — The Finished Web Page

* World Class CAD Challenge 30-10 * - Create a simple web page in the web project folder that
has a regular text banner, a hyperlink to the home page, a single image, bulleted information, a
mail to link and a copyright statement. Repeat this exercise at least two more times to maintain
your World Class ranking.
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